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Welcome to today’s Webinar. Thank you so much for joining us today!

My name is Julie Vitale. I’'m a member of the DISQ Team, one of several groups engaged by
HAB to provide training and technical assistance to recipients and providers for the AIDS Drug
Assistance Program Data Report (ADR).



Today's Webinar is Presented by:

Steve Overman Julie Vitale she/her
SteveOverman@jprog.com Data.TA@caiglobal.org

JProg’ DlS()

The ADR is the report that the AIDS Drug Assistance Programs or ADAPs complete each year. ADAPs are the states
and territories that provide insurance and drug assistance services. If you work for a state or territory’s ADAP
program and use CAREWare to manage your ADAP data, this webinar is for you! If not, you are more than
welcome to stay, but this might not apply to you.

Throughout the presentation, we will reference some resources that we think are important. To help you keep
track of these and make sure you have access to them immediately, my colleague Isia is going to chat out the link
to the presentation slides right now which include all the resources mentioned in today’s webinar.

At any time during the presentation, you’ll be able to send us questions using the “Q&A” function on the settings
bar on the bottom of the screen. All questions will be addressed at the end of the webinar in our live Q&A
portion. During that time, you will also be able to ask questions live if you’d like to unmute yourself and chat with
us directly.

Now before we start, I’'m going to answer one of the most commonly asked questions about the recording. The
recording of today’s webinar will be available on the TargetHIV website within one week of the webinar. The
slides are already available for you to access on the TargetHIV website using the link that Isia just chatted out.
Please note that these slides are not 508 compliant, but we will follow up with all registrants in about two weeks
when the 508 compliant slides and written question and answer are posted.
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Disclaimer

Today’s webinar is supported by the following organizations and the
contents are those of the author(s) and do not necessarily represent the
official views of, nor an endorsement by, the Health Resources and Services
Administration (HRSA), the U.S. Department of Health and Human Services
(HHS), or the U.S. government.

The DISQ Team is composed of
CAIl, Abt Associates, and Mission jProg is the developer of CAREWare
Analytics and is supported by and is supported by HRSA of HHS
HRSA of HHS as part of a as a part of a contract totaling over
cooperative agreement totaling $3.6 Million.

over $4 Million.

Today’s webinar is supported by the organizations shown on the slide, and the contents are
those of the author(s) and do not necessarily represent the official views of, nor an
endorsement, by the Health Resources and Services Administration, the U.S. Department of
Health and Human Services, or the U.S. Government.
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Using CAREWare for ADR reporting - Agenda

* What makes a client appear on the ADR from CAREWare data entry?
» Data entry

* Creating the ADR Client-level Data XML file from CAREWare

+ CAREWare tools for reviewing the data

* Resources

* Questions

Thanks, Julie. Today we’ll be talking about using CAREWare for ADR reporting. The
presentation is designed to answer these questions: where do | enter data in CAREWare for
the ADR and how do | prepare, run and review my ADR Client Level Data file. Today’s
presentation will not cover topics relating to importing data or configuration of ADAP
domains in CAREWare. Here are the points we’ll be covering today:

What makes a client appear on the ADR from CAREWare data entry?

Where data lives that is used to collect and calculate values for the ADR

How to create the ADR Client Leve Data XML file from within CAREWare itself
How do | use CAREWare tools for reviewing the data

What resources can we review to using CAREWare for the ADR

Then, we will open up for questions

Let’s start with a poll to gauge the attendees’ history of CAREWare with the ADR. Isia, would
you launch the poll please?



How many times have you used CAREWare to complete your yearly ADR requirement?

* Never before! This will be my first time.
* Just once

* 2-3 times

* more than 3 times

{Reflection re: ADR experience of users}
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What makes a client appear on the ADR from
CAREWare data entry?

» The client is entered in CAREWare.
» First Name
» Last Name
+ Date of Birth
* Gender (how the client self-identifies)
* The client is enrolled at any time during the calendar year in CAREWare.

* The client is not:
* HIV-negative (affected)

* Important note: the client will appear even if they did not receive services in the year.

Ok, let’s get started by talking about what criteria are necessary to make someone appear on
the ADR?

First, the client must have a record in CAREWare. Every client record must have a first name,
last name, date of birth and a gender. Just like with RSR, gender is a self-report field.

Second, the client must be enrolled at any time during the calendar year of the ADR.

Clients whose HIV status is HIV-negative (affected) are not included in the ADR. A client does
not need to have actually received medication or insurance services to appear on the ADR.



ADR Manual Appendix A: Rrequire Client-
level Data Elements

Id# Client-level Data Elements d Al
Id#  Client-level Data Elements

Type of Client

Type of Service
Health

Clients
System Variable

System Variables

2

Client Demographics 15

Encrypted Unique Client
Identifier

Enrollment and Certification

New client

Date completed application

New

Existing  Disenrolled

Insurance

Medication

Client’s self-reported was received
ethnicity 16 Date completed application
Cllent DemOgra phICS 68 Client report Hispanic was approved
subgroup 17 Date of last eligibility
5 |Client’s self-reported race confirmation ‘
ope . . . 18 Client Enrollment Status
69 | Client report Asian
Enrollment and Certification S ‘ 15 | newsonty forbienralment .
70 Client report Native Health Insurance Services
Hawaiian/Pacific Islander 20 Receipt of Health Insurance .
Health Insurance Services subgroup Services
6 Client’s current self- 67 Type of Health Insurance
reported gender Assistance Received
d B H . 71 Client’s sex at birth 21 Amount Paid for Premiums
Medication Services 0 |CEmEra | |22 | Months Coverageof ‘
10 | Client’s HIV/AIDS status Eremim=lEsid
11 Client’s percent of the ‘ 23 Amount Paid for Medication
ini i Co-payments and
Clinical Information federal povertylevel Deductible
13 | Client’s health coverage Medication Assistance Services
4 ci':"_'_stse'f"e‘“’"“ ‘ 25 | Receipt of Medication .
ethniclty Services

Medication(s) Dispensed
Medication Dispensed Date
Day(s) Supply of Medication

ADR Manual z
Appendix A: Required Client- e aeaen

| cinicalmformation | -
Ievel Data E Iements 32 | CD4 Count Dates .

33 | CD4Test Counts

34 | Viral Load Dates
35 | Viral Load Test Counts

This is Appendix A of the ADR Manual. Here, you can see what requirements appear for
different clients, based on their enrollment statuses and the ADAP services they received.

The data elements are separated into 6 sections

(Click) — System Variable

(Click) - Client Demographics

(Click) - Enrollment and Certification
(Click) - Health Insurance Services
(Click) - Medication Assistance Services
(Click) - Clinical Information

To be clear, this is true of all ADAPs, regardless what system they are using.


https://targethiv.org/sites/default/files/media/documents/2024-02/2023%20ADR%20Manual_ADA.pdf

System Variable

Client Demographics
Enrollment and Certification

Health Insurance Services

Medication Services

Clinical Information

CAREWare

CAREWare makes this simpler for ADAPs when they use an ADAP domain in CAREWare to manage their clients
and services. When generating the ADR Client-level data file, CAREWare is programmed to create the System
Variable, also known as the Encrypted Unique Client Identifier for each client record, and ensures that the right
data elements are reported for clients according to these specifications.

CAREWare collects data for the ADR in different places in the system. Here, I've highlighted the different “landing
spots” where data is collected.

(Click) - Client Information is collected in Demographics and Annual Review.

(Click) - This is also where the Name, Date of Birth and Gender variables are collected to create the Client UCI.
(Click) - Enrollment and Certification is tracked in the Enrollment Status and ADAP Enrollment History sections of
the Demographics screen.

(Click) - Health Insurance Services are entered in Insurance Services.

(Click) - Medication Services are entered in Drug Payments.

(Click) - Finally, Clinical Information is entered in the Labs section of CAREWare.

This is Appendix A of the ADR Manual. Here, you can see what requirements appear
for different clients, based on their enrollment statuses and the ADAP services they
received.

Some

The data elements are separated into 5 sections

Client Demographics Enrollment and Certification Health Insurance Services
Medication Assistance Services Clinical Information



4

ADR Client-level Data Elements in CAREWare

Location of ADR Client Level Data Elements

Demographics
Field
1D Field Name Coding Location in CAREWare
Auto-calculated by CAREWare from first and last name, date|
i i . . f birth, and gender of each client
LEJnlque client ID (eUCI) Encrypted using hash function of birth, and gender of each clien
ncrypted
2
« Hispanic/Latino
. - » Non-Hispanic/ Latino Demographics>Race/Ethnicity - Hispanic or Latino field
\r,:hza)lt'tlesdﬂ;?hﬂil(e:i?’? selfy Note: Only the two options listed under coding count for the
P v? ADR, unknown is excluded and results in missing in the ADR
4
o Mexican, Mexican
American,
Chicano/a Demographics>Race/Ethnicity
Hispanic Subgroups e Puerto Rican Check each Hispanic ethnicity that is true. (The Hispanic or
(Select one or more) e Cuban Latino field value must be set to
« Other Hispanic, Yes to see these options.)
Latino/a or Spanish origin
68

As a reference, the CAREWare programmers have created this resource called the Location of
ADR Client Level Data Elements, to demonstrate where each data element lives in CAREWare,
and relevant details about how data is captured and calculated.


https://hf-files-oregon.s3.amazonaws.com/hdpjprog_kb_attachments/2024/02-09/eaf8a0c2-eb2e-4e55-895f-782f3ce2d88d/ADR_Location_Client_Level_Data_Elements.pdf

4

® Find Client> Search Results > View Details > Demographics
Customize
; Back
Demographics
Client Report .
Drug Payments ®Demographics
Insurance Services
Annual Review
» Personal Info Client ID: 321 Name: Test, Patient Gender: Male DOB: 09/01/1968
Case Notes &
Hospital Admissions
Medications Change URN PTTS0901681U
. Labs S —
123 Sesame St
Demographics s o omatons ] o 10001
Screening Labs g 123-456-7890
Enroliment & oo
Referrals » Race/Ethnicity Pacific Islander (Native Hawaiian), White

C rt 'f' t' Relations e
e I I ca I o n Counseling and Testing HIV Risk Factors No description supplied

Pregnancy History

Orders
» Enroliment Status Current Status: Enrolled, services not requested
FliZEiED ——
Appointments
Cap On Charges Vital Status Vital Status: Alive

User Messages
rch Ch il Current Status: Enrolled, services not requested First enrolled on: 02/02/2019 Latest

Search Change Details W) ADAP Enroliment History Sl o I ey

Duplicate Client

Performance Measure v ’

»

Lets take a closer look. (Click) - Starting with Demographics, there are several submenus to
capture the client information for the ADR.

HIV Status CDC defined AIDS

(Click) - The submenus involved are Personal Info, Race/Ethnicity, Enrollment Status, ADAP
Enrollment History, and HIV Status.

(Click) - Lets take a look at Enrollment Status
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Demographics — Enroliment Status

® Find Client > Search Results > View Details > Demographics > Enroliment Status
Customize

‘Demographics Save ADAf]Enrollment History  Cancel

Client Report

By nents Enroliment Status

Insurance Services

Annual Review Current ADAP Enroliment Status:  Enrolled, receiving services

Case Notes

Hospital Admissions Last Date of Eligibility Confirmation: | 08/20/2023

res'cat'ons Application Approved Date: | 01/03/2023
abs

Screenings Application Received Date: | 12/29/2022 E

SEEETIEES First ADAP Service: | 02/01/2023
Sharing Requests

Referrals

Relations

Counseling and Testing
Pregnancy History
Orders

Adherence
Appointments

Cap On Charges

User Messages
Search Change Details

Enrollment Status and ADAP Enrollment History are where program eligibility is tracked in
CAREWare. If a client you expect to be on the ADR doesn’t appear, this is the place to check
first.

In this form, the only field a user can edit is the Application Received Date. The Application
Received Date is the date the client's initial completed application was first received. Once
entered, this date should never be updated.

All the other dates are calculated.

Application Approved Date is the earliest ‘enrolled’ record in the ADAP Enrollment History.
Subsequent eligibility confirmations should be entered in ADAP Enrollment History. The most
recent one will show here on the Last Date of Eligibility Confirmation.

(Click) - If you click ADAP Enrollment History, you are brought to the page that allows you to
track enrollment events for the client.

11



ADAP Enrollment Histo

formation.hem « p@oc 0D 0P i

»

R State ADAP Program > Doe, Jane ( Birthdate: 1/1/1990, Last service: )
X7 JProg”
Ryan White HIV/AIDS Program

® Find Clent » Search Rosuits » View Detals » Demograghics > ADAP Envolment Hstory
Custormize.
View hdd En Delle Back FrntorExped  Hida'Show Coksns

S ADAP Enroliment History
S
T oe Eovon s Rasson For Dsaromant omarone
) suranca Sanicas B TR -— Prorom ot o chsnged. ot o e o ¢
Ravan N2 Eorobe ervoms ot et

Vitel Signs

Modcaices

Counselig and Testing
Frognancy Hatory
Ordors

Adprrence
Agpcinimants

Gap On Cravges

el Rowi(20 | 64 Padt ot b N D Owiemtmzezees L

There are Four enrollment statuses:
Enrolled, Receiving Services
Enrolled Services not requested
Enrolled, on Waiting List and
Disenrolled

A client will appear on the ADR if they are enrolled during any part of the calendar year, even
if carried over from the prior year.

If a client is disenrolled, a reason must be selected. In this example, their reason for being
disenrolled due to no longer being eligible for the program. This client would be reported
both on this and next year’s ADR, because their status was Enrolled, Services not Requested
until they were disenrolled a few months into 2024.

12
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Annual Review

® Find Client > Search Results > View Details > Annual Data
Customize
Back
Client Summary ®Annual Data
Demographics
Client Report
Encounter Report Annual Screenings View or Edit the client's Annual Screenings
Drug Payments
Insurance Services Insurance Assessments View or Edit the client's Insurance Assessments
Annual Revil _—------
Case Notes i . i
Poverty Level Assessments View or Edit the client's Poverty Level Assessments
Custom Forms
Vital Signs
Hospital Admissions Annual Custom View or Edit the client's Custom Annual data
A

The clients’ poverty level assessments and insurance assessments are found by clicking the
annual review hyperlink. All clients are expected to have at least one insurance assessment

and a least one poverty level assessment in the reporting year. You should report all
insurances a client had in the year.

Lets take a look at Insurance Assessments.
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Insurance Assessment

® Find Client > Search Results > View Details > Annual Data > Insurance Assessments
Gustomize
Save Cancel

Glient Summary
Demographics Add
Gient Report )
Encounter Report Insurance Assessment Date: [ |4
Drug Payments
Insurance Services

Primary Insurance: [

Annual Review RSR
Case Notes - o
. sociation Plan: (]
Vital Signs High Risk Insurance: ()
Hospital Admissions
Medications Indian Health Service: (]
Fabs Medicaid, CHIP or Other Public Plan: (]
Screenings
Screening Labs Medicare (unspecified): (]
Immunizations

n Medicare Part A/B: (]
Diagnoses
Sharing Requests Medicare Part C: ()
Referrals
Relations Medicare Part D: ()

Gounseling and Testing No Insurance: (]

Pregnancy History
Orders. Other Plan: (]
Adheren

Here we see the insurance assessment screen. You enter the date of the insurance
screening, then select the primary insurance type in the dropdown, and then check
off any other insurances the client may have in the reporting year.

14
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Annual Review

® Find Client > Search Results > View Details > Annual Data
Customize
) Back
Client Summary @®Annual Data
Demographics
Client Report
Encounter Report Annual Screenings View or Edit the client's Annual Screenings
Drug Payments
Insurance Services Insurance Assessments View or Edit the client's Insurance Assessments
Annual Revi
Case Notes ) . i
Poverty Level Assessments View or Edit the client's Poverty Level Assessments
Custom Forms —————————
Vital Signs
Hospital Admissions Annual Custom View or Edit the client's Custom Annual data

N g 9969 -
S

Next, lets take a look at Poverty Level Assessment, which is also under Annual
Review.
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Poverty Level Assessment

e Find Client > Search Results > View Details > Annual Data > Poverty Level Assessments
Customize
Save Cancel
Client Summary Add
Demographics . ).J Ent lue f rty td t‘ T
) : nter a value for poverty leyelassessment date
Client Report LEE J 4 s & X
. Enter a value for the Household size Household
Encounter Report Household Size: ) | Size must be greater than zero
Drug Payments Household Income: | < Enter a value for the Household Income
Insurance Services
Annual Review Individual Income: $
Case Notes
Custom Forms
Vital Signs
Hospital Admissions

For the client’s Poverty Level Assessment, Date, Household Size and Annual
Household Income are required fields. CAREWare will calculate the Federal Poverty
Level for you from the Household Size and Household Income. Individual Income is
not required for the ADR, but might serve a local purpose. Isia, would you launch the
first knowledge Check please?

16



Knowledge Check #1

)

For which clients should the health coverage be reported?
1) Clients with an insurance service in the reporting year

2) Clients with a medical service in the reporting year

3) Clients with any ADAP service in the reporting year

4) All clients, with or without services in the reporting year.

Correct answer: 4) All clients, with or without services in the reporting year.

17
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Drug Payments

® Search Results > Print > Search Results > View Details > Drug Payments > Add
Customize Save Back
Demographics
Client Report Add
Drug Payments ; =
Insurance Servic Date: | { Date is required for a Drug payment
Annual R =3
nnual Review Dispenser: ‘ : Dispenser is required
Case Notes
Hospital Admissions DrugiNDC: | —~ ‘7
Medications mp Funding: | ‘ K Funding is required
X
Labs Days: | 4 Enter a valid value for days
Screenings J {x
Units: | J<_Enter a valid value for Units
Screening Labs —
Sharing Requests unitPrice: [ |s =
Referrals Drug Cost: | _Enter a valid value for Drug Cost
oo L —

Counseling and Testing

Pregnancy History ToiCost: [ s

Orders Drug Payment Comments: ‘

Adherence ‘
Appointments
c

Next, Drug Payments for medications are entered here for clients. The required fields are:

Go To Bottom

Date
Dispenser
Drug NDC
Funding

Days

Units

And Drug Cost

When entering drug payments manually, CAREWare will warn you if you are missing a necessary
field entry, as shown here.

(click) - Important note — the value for Funding must be set to “ADAP” for the payment to be
reported on the ADR!

18
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Missing Drugs/NDCs (National Drug Code)

Find Client > Search Results > View Details > Drug Payments > Add

® Cusiomize Save Back

Demographics

Client Report Add

. S E— R
Insurance Services pate: e

Annual Review Dispenser: ‘ |4 4« Pagei  [of918 B NJ‘ [ 4]

Case Notes Drug/NDC: [new 2]

Hospital Admissions Funding:  albumin human(d02376), Albumin Human, 13143030136, 5%, 250, New York Blood Center
'L“:l:’s'ca""”s o3ys:  albumin human(d02376), Albumin Human, 13143030142, 5%, 500, New York Blood Center
Screenings Units: albumin human(d02376), Albumin Human, 13143030231, 25%, 50, New York Blood Center
Screening Labs UPEPIEE albumin human(d02376), Albumin Human, 13143030234, 25%, 100, New York Blood Center
Sharing Requests Lo e —

Referrals Dispense Fee: [0.00 ]s

Relations Total Cost: s

Drug Payment Comments:
Pregnancy History
Orders
Adherence Go To Bottom
Appointments -

Can.On Charoes

If you trying to enter a drug and it doesn’t appear on the Drug/NDC dropdown, you might
have to update the ADR medication list.

Counseling and Testing ‘ ‘
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Managing NDCs

R Jjuvitale > State ADAP Program
®

Y IProg
Ryan White HIV/AIDS Program
. Administrative Options

Customize
Add Client A = =

@®Administrative Options

Find Client
Reports
Rapid Entry Employee Setup Link a user account to employee information Go To TOp
Appointments et =
My Settings Manage NDCs Manage the ADAP Drug Formulary
System Information —
System Messages (6)
Administrative Opt{pns Drug Pasycrrlwﬁcné:ur\cmg Manage Drug Payment Funding Sources
Switch Providers
Log Off
My Links Manage Referral Setup Manage external providers, referral classes and more

HRSA.Gov CAREWare Resources: ADR Medication List
]

As new drugs are available to clients, the drug lists in CAREWare need to be updated on a
regular basis. You can find that list on the HRSA website at this hyperlink.

To do this, goto Administrative Options, and then Manage NDC'’s.


https://ryanwhite.hrsa.gov/grants/manage/careware
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Managing NDCs

x juvitale > State ADAP Program
vy #]Prog

Ryan White HIV/AIDS Program

® st Administrative Options > Formulary Management
Add Client Help Back
Find Client
Reports
Rapid Entry @®Formulary Management
Appointments
My Settings
System Information Import New NDCs Current file: ADAPDrugfiles.xml. Up on: 03
System Messages (6)
AdMSIBiveIOpHons Upload New ADAP file Update the available medication list
Switch Providers ——————
Log Off
My Links Manage Current NDCs 9173 total Available Formulary Items

Managing NDCs
]

Once you’ve downloaded the newest file, you can upload it on the Formulary Management
Page.

(Click) - You can also manage your formulary if you don’t have an open formulary.

Please refer to the Jprog resource for more information on this at this hyperlink.


https://jprog.happyfox.com/kb/article/10-manage-ndcs/
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Managing NDCs

x Juvitale > State ADAP Program At .
A\ 4 “eweProg

Ryan White HIV/AIDS Program

. Customize
Add Client
Find Client
Reports
Rapid Entry
Appointments
My Settings
System Information
System Messages (6)
Administrative Options
Switch Providers
Log Off
My Links

Managing NDCs

If a new medication is on your formulary that is not available in the NDC file, you can
add a placeholder that will allow you to enter data for the medication. You will need
to enter the NDC with all the leading zeroes.

Next, we'll talk about insurance services, but first...time for a knowledge check... Isia,
would you launch the next knowledge Check please?

22


https://jprog.happyfox.com/kb/article/10-manage-ndcs/

Knowledge Check #2

True/False
Within 1 week of FDA approval, all new medications are automatically updated in CAREWare.

False

23
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Health Insurance Services

® Customize
Demographics
Client Report
Drug Payments
Insurance Servi
Annual Review
Case Notes
Hospital Admissions
Medications
Labs
Screenings
Screening Labs
Sharing Requests
Referrals
Relations
Counseling and Testing
Pregnancy History
Orders
Adherence

Ok, now let’s talk about insurance services. These are the fields required for an Insurance
Service:

Date

Contract

Service Name
Months Covered
Price

Total

As with Drug Payments, CAREWare will warn you if you are missing a necessary field entry,
as shown here. You do need to choose a Service Name for some of the fields to load.
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ADAP Insurance Services and the CAREWare Subservices

e stanc CAREWare subservice (short name)
Category

High-risk insurance premiums-full payment (ADAP)

Medicare supplement premiums-full payment (ADAP)

Other health insurance premiums-full payment (ADAP)

High risk insurance premiums-partial payment (ADAP)

Medicare supplement premiums-partial payment (ADAP)

Other health insurance premiums-partial payment (ADAP)

High-risk insurance deductible (ADAP)

High risk-insurance copayment (ADAP)

Medicare supplement deductible (ADAP)

Medicare supplement copayment (ADAP)

Copay/Deductible Other health insurance deductible (ADAP)

Other health insurance copayment (ADAP)

Medicare Part D copayment (ADAP)

Medicare Part D deductible (ADAP)

Medicare Part D Out-of-Pocket (ADAP)

Full Premium
payment

Partial Premium
payment

Note, the following subservices will not map to the ADR: High-risk insurance premiums (ADAP),
Medicare supplement premiums (ADAP), Other health insurance premiums (ADAP).

With Insurance services, it is important that you pick the correct subservices so the services map
correctly for the ADR. This table lists the available CAREWare subservices that you can use for each
ADR insurance assistance category.

In addition, the following subservices will not map to the ADR:
*High-risk insurance premiums (ADAP)

*Medicare supplement premiums (ADAP)

*Other health insurance premiums (ADAP)

They exist in CAREWare because previously in the ADR, ADAPs did not have to distinguish between full
and partial premiums. ADAPs may use these subservices for local purposes only, but any subservices
reported using these categories will not be reported in the ADR.

Likewise, if you create your own subservice, it will not map correctly for the ADR.

The full list of insurance services that are valid for ADR are listed in ADR Client-level Data Elements.

Please reach out to the CAREWare Help Desk for assistance if you believe your subservices are not set
up correctly.


https://hf-files-oregon.s3.amazonaws.com/hdpjprog_kb_attachments/2024/02-09/eaf8a0c2-eb2e-4e55-895f-782f3ce2d88d/ADR_Location_Client_Level_Data_Elements.pdf
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Clinical Information: Labs

R HRSA State ADAP Program > Test, Patient ( Birthdate: 9/1/1968, Last service:
1/13/2023 ) jProg’
A\ 4 8

. Ryan White HIV/AIDS Program

® Find Client> Search Results > View Details > Labs
Customize
Demographics View Add Delete HL7 Source Back Help Back Printor Export Hide/Show Columns
Client Report
Drug Payments La bS
Insurance Services
Annual Review Search: ‘
Caliass Date Test Name Test Operator  Test Result Assay Provider Comment
Hospital Admissions
Medications 01/13/2023 Viral Load >= 200 (Copies/mL) Other/Unk State ADAP Program
Labs 01/13/2023 CD4 Count >= 200 (cells/mm?) State ADAP Program

Screenings
Screening Labs
Sharing Requests
Referrals

Finally, the two ADR-required labs, CD4 and Viral loads, can be entered under the
Labs hyperlink.

Viral load and CD4 Counts are both entered as quantitative labs with a number for
the test result in CAREWare. This is typically straightforward for the CD4 count, but
Viral Load results can come in with a qualitative result, a description such as
“Undetectable” or “Not Detected.” These need to be entered or imported as a
number, which is the minimum detection threshold of the test (often this is 20). If
you are not sure what the minimum detection threshold is, use zero. Reach out to the
DISQ team if you would like any additional support on this.

26
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Running the ADR

27
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23 testbox jorog.net/careware/rs/index htm *

0o e 0D L0O9P:
v @ 20nuosmnml @ Co

R Jprog_steve_testbox > State ADAP Program

Provider Summary (3 Charts As of 6:33 AM)
Active Clients

ADR Client
Report

New Clients (EHE)

et Thab hraa. goviprogram. 8%
arants mansgamens womars

To create the special XML file that you will submit to the Electronic Handbook, go to
Reports: HRSA Reports: ADR Client Report in your CAREWare ADAP domain. Select

the ADR submission year and Select Run. Save the file to a secure network or local
location.

Here are the steps with the video: Go to Reports, HRSA Reports, ADR Client Report,
Select the Reporting Year and click Cross Provider Labs if desired, click run, click
download ADR file saving to your desired location.

28
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Reviewing the ADR

29



CAREWare’s ADR Viewer

CAREWare Reports > HRSA Reports > ADR Viewer > ADR Viewer

View Client List Back Print or Export

ADR Viewer

Search:

Category Count =
Total Unduplicated Client Count 16

4. Ethnicity

4. Hispanic 1

4. NonHispanic 15

68. Hispanic Subgroup

68. Mexican, Mexican American, Chicano/a 0

68. Puerto Rican 0
68. Cuban 0
68. Another Hispanic 0

6. Race (Duplicate Counts Possible)
6. White: 8

6. Black -

The ADR Viewer allows you to review the ADR Client Level Data File that is going to
be submitted. You can check each data element for accuracy, and look at Unknown,
Missing, and “No” values here for completeness.
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CAREWare’s
ADR Validation Report

CAREWare Reports > HRSA Reports > ADR Viewer > ADR Viewer
View Client List Back Print or Export

ADR Viewer

Search:

Category Count -
Total Unduplicated Client Count 16

4. Ethnicity
4. Hispanic 1
4. NonHispanic 15

68. Hispanic Subgroup

68. Mexican, Mexican American, Chicano/a 0

68. Puerto Rican 0
68. Cuban 0
68. Another Hispanic 0

6. Race (Duplicate Counts Possible)
6. White: 8
6. Black: 2

EHB’s Upload
Completeness Report

2023 ADR Client-Level Data Upload Completeness Report
Grant Number: Report Period:  01/01/2023 - 01/01/2024 Report Id: 32301

Recipient Name:  CAREWare Total Clients: 25

Summary Data

2023
Population N %
Total clients submitted 25 100.0%
Clients who received insurance services 17 68.0%
Clients who received ADAP-Funded medications 1 44.0%
Clients with no services reported 7 28.0%
Demographic Data
Ethnicity (Item #4)
Current year Denominator: Number of unique clients reported (N = 25)

2023
Ethnicity N %
Hispanic/Latino(a) 5 20.0%
Non-Hispanic 20 80.0%
Missing/Out of range 0 0.0%

7

This report is very similar to the Upload Completeness Report of in the EHBs, with the added
advantage of being able to quickly get a list of clients for any data element and click right to

the record of any client in the list. Let’s take a look.
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Happy Testbosing!

To get to the ADR Viewer, Navigate to Reports: HRSA Reports: ADR Viewer. Select Choose

File and select the ADR Client Report XML file you downloaded earlier. Then, select “View
ADR File”

In the list view, keep an eye out for any values in Unknown or Missing for the different data
points. These may be things you can complete to make your data the best possible. To view
clients with these statuses, select the row, then “View Client List.”

Remember that correcting these values does not update the file. When you have completed
all the reviews, corrections, and changes, create another ADR Client XML file to incorporate
the changes you’ve made.
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Check #
36
44
65
72
86
87
%
9%
%
103
105
106
108
12
17

CAREWare’s
ADR Validation Report

Validation Message Severity
Clients with age of 90 years old or older Warning
Clients with New Enroliment reported as ‘yes' but missing AD/ Alert

Clients missing CD4 Test Warning
Clients missing Viral Load Test Warning
Clients missing Ethnicity Warning
Clients missing Race Alert
Clients with Asian race missing Asian subgroup Alert

Clients did not receive Insurance Assistance or Medication As: Alert
Clients with missing Race and missing ethnicity Warning
Clients with missing or invalid HIV/AIDS Status ID Warning
Clients with missing or invalid current MedicallnsurancelD Warning
Clients with enroliment status of 'Enrolled, on Waiting List' Alert
Clients with insurance premium assistance months outside of Alert
Clients with Last Eligibility Confirmation Date required but Las' Alert
Clients missing Poverty Level Percent. Warning

# Clients

Next, the ADR Validation Report allows you to review what’s going to be submitted

for validation messages.
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CAREWare’s
ADR Validation Report ’ idati
alidation Repo EHB’s Validation Report
A - - - -
Check # Validation Message Severity # Clients ::w ﬁ:eck e Type
36 Clients with age of 90 years old or older Warning 1
i " e 1 client(s) reported with missing CD4 test. CD4
44 lien ith N nroliment re it missing AD# Alert 4
Clients with New Enroliment reported as ‘yes’ but missing AD# Alel » 1 65 {ests should be reported for all clients Warning
65 Clients missing CD4 Test Warning 17
) . ) . 1 client(s) reported with missing Viral Load test.
72 Clients missing Viral Load Test Warning 17 y 2 72 Viral Load tests should be reported for all Warning
86 Clients missing Ethnicity Warning 1 clients
87 Clients missing Race Alert 1 .
» 3 86 1 client(s) missing ethnicity. Warning
920 Clients with Asian race missing Asian subgroup Alert 1
95 Clients did not receive Insurance Assistance or Medication As: Alert 6 » 4 87 1 client(s) missing race. Alert
96 Clients with missing Race and missing ethnicity Warning 9 L s o 1 Clieni(s) with missing Race and missing warming
103 Clients with missing or invalid HIV/AIDS Status ID Warning 8 ethnicity.
105 Clients with missing or invalid current MedicallnsurancelD Warning 17
6 103 1 client(s) with missing or invalid HIV/AIDS Warmi
106 Clients with enroliment status of ‘Enrolled, on Waiting List  Alert 2 D Status ID. —
108 Clients with insurance premium assistance months outside of Alert 4 Vo o5 1 clieni(s) with missing or invalid current e
112 Clients with Last Eligibility Confirmation Date required but Las' Alert 2 MedicallnsurancelD.
17 Clients missing Poverty Level Percent Warning 27
» 8 17 1 client(s) missing Poverty Level Percent. ‘Warning

This is very similar to the Validation Report in the EHBs. This report also has the
added advantage of being able to quickly get a list of clients triggering a validation.
You can quickly go to the record of any client in the list. Let’s talk a bit more about
validation messages.
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Three Types of Validation Messages

N Errors: Data with errors are not accepted. You must edit your data
and re-upload.

Warnings: In response to warnings, you should go back and look
at your data to see if edits can be made. If edits cannot be made,
you will need to submit a validation comment explaining why
your data look the way they do.

] Alerts: Alerts are informational and do not prevent submission.
However, please make corrections as necessary if you receive a
validation alert.

Validation Reports are divided into three severity classes: errors, warnings, and alerts

An error severity level is a show stopper. You won’t be able to submit your ADR Client File if
this is not fixed. One of the many advantages that CAREWare users have is that its impossible
to end up with an Error. The checks and balances within XML file creation process eliminates
the risk of exporting a file that either does not pass the schema check or has an error. In fact,
the only error you could run into with CAREWare CLD files is forgetting to upload it to the
Electronic Handbook!

A warning on the other hand, will require explanation or comment, to be able to submit your
ADR Client-level data file in the Electronic Handbook. An example of this is a client with a

missing viral load. The comment may be something like, “a patient left the state and was lost
to care.”

Alerts are items to review to make sure that your data is correct. An example is an alert that
a client has been reported to be over 90 years of age. Thankfully, we are seeing more and
more of our clients living into their 90s!
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Ryan White HIV/AIDS Program

Validation
Report

The ADR Validation Report is also within HRSA Reports.

Let’s take a look. We click ADR Validation Report, select the year, cross provider labs if we want,
and run. We then click view ADR Validation Report. For each row, we see a client count for each
check. We can select the row and then View Client List to go into the clients’ records and add
information as we verify it from the EMR or case management system. Let’s check out who's
missing Viral loads in 2023’s ADR Client File. Click the validation row, then view client list. We
select the client in the list and Go To Client. Then we can review the client’s labs and add the
missing data if it’s present in other records that had not made it into CAREWare.

After you have done all your changes through the client viewer, run the validation report to check
for anything you may have missed. Correct these issues.

Finally, when your data is as complete and error free as possible, create a final Client File, naming
it something that denotes it’s the submission file. The next steps for submission to EHB are
outside the scope of this presentation, but there are several TA resources on TargetHIV to help
you with this.

Let’s Check our Knowledge! Isia, would you launch the final knowledge Check please?
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Knowledge Check #3

)

Which of the following require comments to submit a client level data file to the
Electronic Handbook?

Alert

Warning
Error

Answer: Warning
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Something you may not have known about...

/4

Here’s a bonus you may not have known about.
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ADAP Financial Report
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7

We added a way to easily create a report that shows Medication utilization.

This is the ADAP Financial Report
The ADAP financial report lets you see how many clients had medications and the totals for those

medications for a period.
Let's go through that.
We go to Reports

ADAP Financial Report

Set our dates
Filter by dispenser, funding source, or other filters if we want, then click run.

Here we see the output
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ADAP Financial Report
ADAP Financial Report
Sunday, January 1, 2023 through Sunday, December 31, 2023
Report Criteria:

Dispensers: All Sources, ADAP, Best Drugs, State of Chaos, Test

Funding Sources: All Sources

Group By: None

State ADAP Program
Dispenser: Funding Source: NDC: Medication: Clients: Units:  Duration: Drug Cost:  Dispense Fee: Total Cost:
ADAP ADAP 00002-0640-02 Seconal Sodium 2 61 67 $357.40 $20.50 $377.90
ADAP ADAP 00002-0640-33 Seconal Sodium 1 168 28 $14,266.56 $12.00 $14,278 56
ADAP ADAP 00002-0665-02 Tuinal 1 10 180 $89.00 $17.00 $106.00
ADAP ADAP 00002-1407-01 QuiNIDine Gluconate 1 1 7 §1.00 $8.50 $9.50
ADAP ADAP 00093-3147-05 Cephalexin Monohydrate 1 168 28 $14,266.56 $12.00 $14,278.56
ADAP ADAP 00173-0661-00 Ziagen 1 365 365 $3,248.50 $8.50 $3,257.00
ADAP ADAP 00173-0664-00 Ziagen 1 10 60 $10.00 $17.00 §27.00

Here’s a close-up of this report.

You can see it shows details on all the medications entered through the Drug
Payments tab. It gives totals such as # of clients and Total Cost for each NDC entered
during the reporting period.
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When Can | Get the ADR Build of CAREWare?

ADR Build 230 has just been
released!

jProg maintains the latest
production-recommended build of
CAREWare, including this one, at:

https://ryanwhite.hrsa.gov/grants/manage/careware

One of our most popular questions at the CAREWare Help Desk is when will the ADR
build of CAREWare be ready. Every year, our programmers update CAREWare to

comply with changes to ADR and to add features and fix bugs. We just announced it’s
release on the CAREWare Listserv.
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Resources for the ADR and CAREWare

* jProg Happyfox Knowledge Base

« CAREWare Knowledge Base
» Create the ADR Client Report XML File
» Review the ADR Client Report with the ADR Viewer

» Review the ADR Validation Report
» Custom Reports for ADR Data Quality

» Other resources related to ADR
» CAREWare Tips for ADAPs: Key Areas That Impact ADR Data Quality

« ADAP Data Report (ADR)

I'd like to give you the hyperlinks to get to some jProg CAREWare resources.

First, we have our knowledge base. This has articles to support you on your ADR and more.
Here are 4 articles you might want to review when completing your ADR this year.

Next, you may want to check out CAREWare Tips for ADAPs: Key Areas That Impact ADR Data
Quality to get your data as best as it can be.

TargetHIV also has a collection of ADR resources, including webinars and print resources to
help you complete your ADR.
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https://targethiv.org/sites/default/files/media/documents/2022-04/ADR%20In%20Focus%20CAREWare%20Tips%20for%20ADAPs.pdf
https://targethiv.org/sites/default/files/media/documents/2022-04/ADR%20In%20Focus%20CAREWare%20Tips%20for%20ADAPs.pdf
https://jprog.happyfox.com/kb/section/2/
https://jprog.happyfox.com/kb/article/11-adr-client-report/
https://jprog.happyfox.com/kb/article/12-adr-viewer/
https://jprog.happyfox.com/kb/article/13-adr-validation-report/
https://jprog.happyfox.com/kb/article/129-custom-reports-for-data-quality/
https://targethiv.org/library/adr-focus-careware-tips-adaps-key-areas-impact-adr-data-quality
https://targethiv.org/library/topics/adap-data-report-adr

J

RWHAP Technical
Assistance Resources

The RWHAP TA Resources
Brochure features information
on each RWHAP technical
assistance provider, including:

* RWHAP reports they
support

* Questions they frequently
respond to

* Contact information

Ryan White HIV/AIDS Program TA Resources

RWHAP Data

| -

Data i -
Systems and Quality
(DISQ)

EHBs Customer
Suppo
Repors: 25

|»

CAREWare

Contact Your
Project Officer

There are several technical assistance resources available to help you with your ADR. The
RWHAP TA Resources brochure outlines information about each technical assistance

provider, including the reports they support, frequently asked questions they respond to, and

their best contact information. You can find this resource on the TargetHIV website.

Most importantly, please don’t forget that there is no wrong door for TA — if we can’t assist

you, we’re happy to refer you to someone who can!

43


https://targethiv.org/library/rwhap-technical-assistance-resources
https://targethiv.org/library/rwhap-technical-assistance-resources

N\

Connect with HRSA

To learn more about our agency, visit

www.HRSA.gov

@ Sign up for the HRSA eNews

orons ® @ @ @

And then lastly, to find out more about HRSA, check out HRSA.gov. I'd like to thank
everyone again for joining us on today’s webinar and now we’ll move onto the Q&A.
I’ll be handing this over to Julie.
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JProg”

Let’'s Hear From You! —

* Please use the “raise hand”
function to speak. We will
unmute you in the order that o weome
you appear.

OR

» Type your question in the
question box by clicking the
Q&A icon on the bottom
toolbar.

Cancel Send

» &

Raise Hand

As a reminder, you can send us questions using the “Question” function on your control panel on the right hand side of the
screen. You can also ask questions directly “live.” You can do this by clicking the raise hand button (on your control panel). If you
are using a headset with a microphone, Isia will conference you in; or, you can click the telephone button and you will see a dial
in number and code. We hope you consider asking questions “live” because we really like hearing voices other than our own.

We do want to get all of your questions answered, and we do not usually run over an hour. If you have submitted your question
in the question box and we cannot respond to your question today, we will contact you to follow up. We often need to explore
your question in order to give you the most appropriate answer.

Lets take a look at your questions?

The next question we have...

Isia, do we have anyone with their hand raised?

Would XXX like to take themselves off mute and explain your question a bit further?

That is a great question! We will have to follow-up with you offline about this question. We’ll need to know a bit more about
your situation before we can answer this.

Would any of my colleagues want to elaborate on this?

Steve, perhaps you can take this one?

Roy, would you mind taking this one?

What other questions do you have?

Remember to fill out your evaluation. We'll be sending out the 508 compliant slides and the Q&A in about two weeks.
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